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System Requirements
The DSC Module Run-Time System runs on any system with the following 
minimum specifications:

• Windows 2000/NT 4.0 or later/XP. The DSC Module Run-Time 
System requires that Windows NT include service pack 6a and the 
6a Security Rollup Package, which are part of the July 26, 2001 
security update available at www.windowsupdate.com. 
LabVIEW 7.1 does not support Windows Me/9x.

• 128 MB of RAM minimum, 256 MB recommended.

• 200 MHz or higher processor speed, 500 MHz recommended.

• 400 MB of disk space to install the DSC Module Run-Time System 
and have swap space available. Increasing computer resources has a 
significant effect on performance of DSC Module applications. 

• 800 × 600 or better monitor display.
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Protecting Against Power Failure
Power failure is a potential threat to system stability. If a computer loses 
power suddenly, data kept in memory is lost and files might be corrupted. 
The only effective protection against power failure is an Uninterruptible 
Power Supply (UPS). A UPS is a device that keeps the computer running 
for at least a short time when the primary power source is lost. It provides 
complete isolation between the AC power source and the computer and has 
backup battery power in case of power outages. If you do not need battery 
backup, you can use a quality surge protector to protect a computer from 
most electrical surges and spikes.

Citadel Database Compatibility
The DSC Module Run-Time System version 7.0 introduced Citadel 5, 
a new version of the historical database. The current DSC Module 
Run-Time System logs to and retrieves from Citadel 5 databases only. 
You must convert Citadel 3.8 or Citadel 4.x databases to Citadel 5 if you 
want to use them with version 7.1 of the DSC Module Run-Time System. 
Refer to the Converting Citadel 4.x Databases section of this document for 
information about converting databases.

Installation

Before You Install
Review the following list of issues before you install the DSC Module 
Run-Time System:

• Make sure that you meet the system requirements listed in the System 
Requirements section of this document.

• If you have a previous version of the DSC Module Run-Time System 
installed, either uninstall that older version or install version 7.1 in a 
different directory. Due to a change in Citadel, you must install a patch 
for version 7.0 if you want to run both version 7.0 and 7.1 on the same 
computer. The patch for version 7.0 is located on the installation CD in 
the Simultaneous Operation Patch folder.

• If you want to preserve custom settings from a previous version of the 
DSC Module Run-Time System, save all .ini and .cfg files in the 
LabVIEW DSC Run-Time System directory to a backup location and 
then copy them to the appropriate location after installing version 7.1.

• If you have Microsoft SQL Server version 6.5 or earlier on the 
computer, you must upgrade to Microsoft SQL Server version 7.0 
or later before installing the DSC Module Run-Time System.
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Installing the DSC Module Run-Time System
Complete the following steps to install the DSC Module Run-Time System.

1. Log on as an administrator or as a user with administrator privileges. 

2. Insert the DSC Module Run-Time System installation CD and follow 
the instructions that appear on the screen.

3. Restart the computer and log on as an administrator or as a user with 
administrator privileges. When you restart, you might have to wait for 
the MSDE setup to complete.

Additional Installations
Install any necessary drivers or data servers as described in the application 
software documentation.

Install the Application Software
Install the application software as described in its documentation. After 
installing the files, make a note of the location of the .scf and .ccdb files.

Update Preference Files
Set up any necessary preference files as described in the application 
software documentation. These files contain non-default settings for DSC 
Module utilities. You can edit these files with a simple text editor such as 
Notepad.

Finish Server Setup
If you are using National Instruments IAS/IAK device servers, you might 
need to resolve the paths to the servers stored in the .ccdb file using Server 
Explorer. Server Explorer is installed when you install the DSC Module 
Run-Time System. In Server Explorer, select File»Open, locate the .ccdb 
file for the application software, and select File»Set this file as Active 
CCDB.

VI-based servers (if used by the application) provide their own Server 
Registration VIs.

Configure LabVIEW Startup VIs
You might want to configure one or more startup VIs as the user interface 
panels that appear when you launch the DSC Module Run-Time System. 
Click the Configure Startup VIs button, shown at left, or select 
Tools»DSC Module»Advanced»Startup VIs in the DSC Module 
Run-Time System. In the Configure Startup VIs dialog box, select the 
appropriate startup VIs. 
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If an application launches the Tag Engine when it runs and the servers are 
not registered properly, you receive error messages identifying the servers 
that did not start. Refer to the documentation for your application to 
determine which servers are required and how to register them. 

Uninstalling the DSC Module Run-Time System
To uninstall version 7.1 of the DSC Module Run-Time System, select 
Start»Settings»Control Panel»Add/Remove Programs. Select National 
Instruments Software and remove NI LabVIEW DSC Run-Time 
System 7.1.

New Feature for Version 7.1
Version 7.1 of the DSC Module Run-Time System includes an 
enhancement to DataSocket. If a DataSocket client loses a connection to 
the DataSocket Server or cannot establish a connection to the DataSocket 
Server, the DataSocket Proxy attempts to reconnect every 60 seconds by 
default. The DataSocket Proxy can reconnect to the DataSocket Server 
automatically, and the Tag Engine does not need to be restarted. To use 
a reconnection interval other than 60 seconds, create a file named 
DataSocket.ini in the vi.lib\lvdsc\servers\DataSocket 
Proxy directory. Create the following keys in the DataSocket.ini file:

ReadReconnection=x

WriteReconnection=x

where x is the reconnection interval in seconds.

New Features for Version 7.0
The following sections describe changes to existing features and new 
features added in version 7.0 of the DSC Module Run-Time System.

Citadel 5 Database
The DSC Module Run-Time System versions 7.0 and 7.1 include Citadel 5, 
a new version of the Citadel historical database. Citadel 5 introduces data 
access from ActiveX Data Objects (ADO) clients and improved Open 
Database Connectivity (ODBC) support.

Database Names
Citadel 4.x identified databases exclusively by their path. Citadel 5 
uses database names. Because of the new Citadel 5 format, the Tag 
Configuration Editor uses a new .scf file format, the ODBC data source 
setup has changed, and the Historical Data Viewer has been updated. 
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Conversion to Citadel 5 Format
The DSC Module Run-Time System versions 7.0 and 7.1 log to and 
retrieve from Citadel 5 databases only. You must convert Citadel 3.8 or 4.x 
databases to Citadel 5 if you want to use them with the current DSC Module 
Run-Time System. Refer to the Converting Citadel 4.x Databases section 
of this document for information about converting databases.

Citadel 5 ODBC Data Source
As with Citadel 4.x, you must have an ODBC data source for Citadel 5 as 
described in the LabVIEW Datalogging and Supervisory Control Module 
Run-Time System Help. However, the following changes have been made to 
the National Instruments Citadel ODBC Setup dialog box.

• ODBC setup asks for a Database URL instead of a database path. 
Database URL is the computer and database name where data for the 
source are stored—for example, \\computer_name\my_database. 
Use a Database URL that matches the existing local or remote 
database you intend to access.

• Use the ... button to browse local and remote databases. 

• Use the Test Connection button to test the connection you are 
setting up.

Expanded Access to Citadel 5 Data
The Citadel 5 ODBC driver is compliant with SQL 92 and ODBC 2.5 
standards. All clients that follow these standards can retrieve data from a 
Citadel 5 database. ADO clients can access the Citadel 5 database using the 
ODBC driver through the Microsoft OLE DB Provider for ODBC Drivers. 
You can use a Microsoft Query Wizard to build queries. 

Creating a Data Link for the ODBC Data Source
If you want to access Citadel data from an ADO client, you need a data link 
to ODBC. You might be able to create the data link from within an ADO 
client, but you might be required to create it multiple times. Alternatively, 
complete the following steps to create a data link once that you can store on 
a system or network. 

1. Create a Citadel 5 ODBC data source, if you have not already done so.

2. Create a new text (.txt) document. 

3. Right-click the new text document and rename it to have a .udl 
extension—for example, data_link.udl. A warning might appear, 
explaining that changing file extensions might cause files to become 
unusable. Disregard this warning. 
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4. Right-click the .udl file and select Properties. In the dialog box that 
appears, click the Provider tab and select Microsoft OLE DB 
Provider for ODBC Drivers.

5. Click the Connection tab and select the Citadel 5 ODBC data source 
name.

6. Click the OK button.

Citadel 5 Tables
Citadel 5 tables are different than Citadel 4.x tables. For more information 
about Citadel 5 tables, refer to the Updating Citadel 4.x SQL Queries 
section of this document.

Storage and Security for Alarms and Events
Citadel 5 uses Microsoft SQL Server or MSDE 2000 (Microsoft SQL 
Server Desktop Engine 2000) to store alarms and events. MSDE 2000 
is a light version of Microsoft SQL Server. The major restriction of 
MSDE 2000 is that the size of one database is limited to 2 GB, so you must 
upgrade to the full version of SQL Server 2000 if an application exceeds 
this 2 GB limit. 

To connect to and access a remote SQL Server database, local and network 
clients can use one of two security modes: Windows Authentication Mode 
or Mixed Mode. Windows Authentication Mode security uses the built-in 
Windows security system and takes advantage of Windows NT domains. 
All clients that need to access SQL Server remotely must be properly 
configured on the same domain to access data stored on remote SQL Server 
computers. Clients must connect through the Windows security system on 
the server. 

Mixed Mode security allows clients to connect to a server using either 
Windows Authentication or SQL Server Authentication. With SQL Server 
Authentication, all user accounts are stored within the SQL Server, and 
clients do not need to go through the built-in Windows NT security system. 
Mixed Mode security is simple to set up because clients need not be on the 
same domain. They only need to have the correct user name and password 
to access the SQL Server. However, SQL Server Authentication is more 
vulnerable than Windows Authentication Mode. 

Citadel 5 uses SQL Server Authentication by default, so network clients do 
not need to be explicitly configured. The DSC Module installer enables 
Mixed Mode security on existing SQL Servers or installs MSDE 2000 with 
Mixed Mode security if the target computer does not have SQL Server 
installed. 
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The default password for the SQL Server administrator sa is left blank. 
NI recommends that you assign a strong password to the sa user. Use the 
following command line utility to set the SQL Server administrator 
password: 

osql -U"sa" -P"" -Q"sp_password NULL, 'new_password', 'sa'"

Use the following command to change an existing password:

osql -U"sa" -P"old_password" -Q"sp_password 'old_password', 

'new_password', 'sa'"

If Mixed Mode security is not acceptable, change both the SQL Server 
and Citadel login modes by setting the registry DWORD values 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSSQLServer\MSSQL

Server\LoginMode and HKEY_LOCAL_MACHINE\SOFTWARE\
National Instruments\Citadel\5.0\IntegratedSecurity to 1. 
This forces the use of Windows Authentication mode.

NI recommends changing the login mode immediately after installing the 
DSC Module. If you change the login mode after you have logged data, 
you must reattach all existing Citadel databases. Restart the SQL Server 
and Citadel services to implement the changes. If you use Windows 
Authentication Mode, remember that you might need to explicitly 
configure the server computer and all clients.

New Version of Historical Data Viewer
With the Historical Data Viewer that comes with versions 7.0 and 7.1 of 
the DSC Module Run-Time System, you can view both Citadel 4.x and 
Citadel 5 databases in Measurement & Automation Explorer (MAX). 
You also can convert Citadel 4.x databases to Citadel 5 format. In addition, 
navigation tools have been added for simpler viewing of data sets. 

Revised Historical/Event Logging Configuration
Citadel 5 databases are identified by names instead of paths. For Citadel 
databases that have not been converted to Citadel 5 format, the DSC 
Module Run-Time System creates a name for the database using its path 
and underscore characters. 

You must give each Citadel 5 database a unique name/path pair. For 
example, you can have a database named Db1 on multiple computers, 
but you cannot have two databases named Db1 on the same computer. 
Database name/path pairs are checked for conflicts when you configure 
historical or event logging and when the Tag Engine launches.
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When you open a .scf file that was created in version 6.x of the DSC 
Module, you are prompted to convert the file and its associated databases 
to the current format. For more information about converting databases, 
refer to the Converting Citadel 4.x Databases section of this document.

Tag Monitor Enhancements
The Tag Monitor that comes with versions 7.0 and 7.1 of the DSC Module 
Run-Time System has the following additional features:

• New display columns for Tag Name and Read/Write Attributes

• New Type Mismatch Checking, XX for Bad Quality, Hex for Raw 
Data, Set Decimal Places, and Select Columns selections available in 
the Options menu

Change in Bad Quality Status
The error status for application-defined quality is now a warning instead of 
an error. For example, a thermocouple out-of-range state from FieldPoint 
now is a warning and not a bad-quality error.

Changes to NI Services
Version 7.0 of the DSC Module Run-Time System introduced a new 
version of the Citadel service, which appears as National Instruments 
Citadel in Windows Services and nicitdl5.exe in the Task Manager. 
To start and stop this or other NI services, use Windows Services, available 
in the Control Panel.

Change to Default Source of Time Stamps
By default in versions 7.0 and 7.1 of the DSC Module Run-Time System, 
time stamps logged to Citadel come from the system clock of the computer 
running the Tag Engine instead of from the server. To have time stamps 
come from the server, change the DSCEngine.ini setting Use Server 
Timestamps to TRUE. Because changing this setting can result in larger 
Citadel databases, NI recommends keeping the default value.

Upgrading DSC Module 6.x Applications to 7.1
After installing version 7.1 of the DSC Module Run-Time System, 
follow the instructions in this section to convert existing DSC Module 
applications.
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Recompiling VIs
To run an application created in a previous version of the DSC Module or 
BridgeVIEW, you must recompile the application VIs in order to upgrade 
them to version 7.1. You must have development versions of both 
LabVIEW 7.1 and the DSC Module 7.1 to recompile VIs. 

Converting Version 6.x .scf Files
When you use the Tag Configuration Editor to open a .scf file created in 
version 6.x of the DSC Module, a conversion wizard launches and leads 
you through the process of converting the .scf file. The wizard also gives 
you the option of converting existing Citadel 3.8 or 4.x databases that are 
associated with that .scf file. If the Tag Engine attempts to access a .scf 
file that you have not converted yet, an error message appears.

The conversion wizard saves a renamed backup of the original .scf file to 
the same location as the new, converted .scf file. 

Converting Citadel 4.x Databases
The DSC Module Run-Time System versions 7.0 and 7.1 log to and 
retrieve from Citadel 5 databases only. You must convert older databases 
to Citadel 5 if you want to use them with the current DSC Module 
Run-Time System. 

Databases Associated with a .scf File
When you open a .scf file created in version 6.x of the DSC Module, 
a conversion wizard launches. After converting the .scf file, the wizard 
gives you the option of converting databases that are associated with that 
.scf file. 

Caution NI recommends using the default conversion options. If you must save the 
converted database to a location other than the default path due to a shortage of hard drive 
space, for example, the application might not work.

To log new data to an existing database, do not log data until you convert 
the database to Citadel 5. If you log data from a converted application 
before converting the database, the DSC Module Run-Time System creates 
a new, empty Citadel 5 database in the same location as the older Citadel 
database and logs data to that new database. To get all the logged data back 
into one database after that happens, you must use the Historical Data 
Viewer to convert the older Citadel database and then merge it with the new 
Citadel 5 database.
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Databases Not Associated with a .scf File
If you choose not to convert a Citadel database when the wizard asks you, 
or if you have an existing database that is not associated with a converted 
.scf file, you can convert the database using the Historical Data Viewer 
in MAX. Click the View Historical Data button, shown at left, in the DSC 
Module Run-Time System window. In the window that opens, right-click 
the Historical Data category, select Create New from the shortcut menu, 
and choose the appropriate conversion in the dialog box that appears. If you 
cannot locate the database you want to convert, you might need to create a 
Citadel 4.x version of it in Historical Data Viewer before choosing to 
convert it to Citadel 5.

Remote Databases
You cannot convert a database remotely. You must convert it on the 
computer where it exists.

Converted Alarms
Alarm priorities logged by version 6.x of the DSC Module Run-Time 
System ranged from 0–10, and those values are retained when converted 
to Citadel 5 format. Alarm priorities logged to Citadel 5 range from 0–15.

Redirecting NI HyperTrend and HTV to Citadel 5 Data
If you convert a Citadel database and an application that uses the 
NI HyperTrend control, right-click the control on the front panel and select 
the tags to display so that data is retrieved from the converted Citadel 5 
database instead of the old Citadel database.

If you convert a Citadel database and an application that uses Historical 
Trend Viewer (HTV), launch HTV and select the tags to display so that data 
is retrieved from the converted Citadel 5 database instead of the old Citadel 
database.

Creating a New ODBC Data Source
For information about creating an ODBC data source for Citadel 5, refer to 
the Citadel 5 ODBC Data Source section of this document.

Updating Citadel 4.x SQL Queries
If you have existing SQL queries for retrieving Citadel 4.x data, you must 
convert them for use with Citadel 5. Refer to Table 1 and Table 2, which 
detail the differences in Citadel 4.x and Citadel 5 queries. 
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For more information about each Citadel 5 database table, refer to 
Appendix A, Using SQL to Access Historical Data in a Citadel Database, 
of the LabVIEW Datalogging and Supervisory Control Module Run-Time 
System Manual.

Citadel 5 Transform Functions
Transform functions have changed with Citadel 5, as shown in Table 2.

Table 1.  Changes in Citadel Tables

Citadel 5 ODBC Driver

Citadel 4.x 
ODBC 
Driver  Description 

Aliases N/A Aliases table is used to map alias names to actual 
tag names.

RawData Points RawData table is used to retrieve the actual values 
logged for a tag and times they were logged. 
You can query only one tag at a time.

IntData Traces IntData table is used to retrieve interpolated values. 
You can query more than one tag at a time. 

DS_RawData_dataset_name N/A DS_RawData_dataset_name table is used to 
retrieve the actual values logged for a tag, times, 
and particular data set where logged. You can 
query only one tag at a time. 

DS_IntData_dataset_name N/A DS_IntData_dataset_name table is used to retrieve 
the interpolated values for a particular data set. 
You can query more than one tag at a time.

Table 2.  Changes in Transform Functions

Citadel 5 ODBC Driver 
Citadel 4.x 

ODBC Driver Description 

MATH_MIN(tag | 
TO_DISCRETE(tag) | 
TO_CONTINUOUS(tag)) 

MIN(tag) Returns the minimum for tag across the 
interval. 

MATH_MAX(tag | 
TO_DISCRETE(tag) | 
TO_CONTINUOUS(tag)) 

MAX(tag) Returns the maximum for tag across the 
interval. 

MATH_AVG(tag | 
TO_DISCRETE(tag) | 
TO_CONTINUOUS(tag)) 

AVG(tag) Returns the average for tag across the 
interval. 
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Standard set functions (MIN, MAX, AVG, COUNT) are supported and you 
can use them on any Citadel 5 table. It is important to distinguish between 
set functions MIN, MAX, and AVG, and Citadel 5 transform functions 
MATH_MIN, MATH_MAX, and MATH_AVG. Set functions perform 
calculations on query results. Transform functions perform calculations on 
interpolation intervals.

Tag names are forced into an accepted format by replacing characters 
within the names with the characters in Table 3. 

MATH_STDEV(tag | 
TO_DISCRETE(tag) | 
TO_CONTINUOUS(tag)) 

STDEV(tag) Returns the standard deviation for tag 
across the interval.

MATH_STARTS(tag | 
TO_DISCRETE(tag) | 
TO_CONTINUOUS(tag)) 

STARTS(tag) Returns the number of starts (that is, the 
number of transitions from OFF to ON) 
for tag across the interval. For numeric 
points, 0.0 is interpreted as OFF, and all 
other numbers are treated as ON.

MATH_STOPS(tag | 
TO_DISCRETE(tag) | 
TO_CONTINUOUS(tag)) 

STOPS(tag) Returns the number of stops (that is, the 
number of transitions from ON to OFF) 
for tag across the interval.

MATH_ETM(tag | 
TO_DISCRETE(tag) | 
TO_CONTINUOUS(tag))

ETM(tag) Returns the amount of time tag was in 
the ON state across the interval.

MATH_QUAL(tag | 
TO_DISCRETE(tag) | 
TO_CONTINUOUS(tag))

QUAL(tag) There might be gaps in the historical 
data traces in Citadel because of a 
computer shutdown, Tag Engine 
shutdown, or similar occurrence. 
MATH_QUAL returns the ratio of time 
for which valid data exist for tag across 
the interval to the length of the interval 
itself. If valid data exist for only 
one-half of the interval, MATH_QUAL 
returns 0.5. 

TO_DISCRETE(tag) N/A Casts current tag type to discrete (that 
is, the tag is treated as discrete). 

TO_CONTINUOUS(tag) N/A Casts current tag type to continuous 
(that is, the tag is treated as continuous).

Table 2.  Changes in Transform Functions (Continued)

Citadel 5 ODBC Driver 
Citadel 4.x 

ODBC Driver Description 
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Long Tag Names and Aliases
Database tables and column names can be only up to 126 characters long 
and cannot contain some special characters. Some ODBC clients support 
names only up to 62 characters long. The database URL is not included in 
a tag or data set name. The Citadel 5 driver automatically generates alias 
names for tags or data sets whose names are longer than the Maximum 
Column Name Length value specified in the ODBC configuration dialog 
box. Alias names consist of a prefix and original tag or data set name 
substring, so the total length of the alias string is equal to the Maximum 
Column Name Length value. An alias prefix has the format 
~XXXXXXXXXXXXXXXX_ where XXXXXXXXXXXXXXXX is 
a 64-bit tag or data set ID. 

Reimporting FieldPoint Configuration
If you communicate with FieldPoint modules in a DSC Module application 
using the FieldPoint IAK server, sometimes referred to as the FieldPoint 
LabVIEW DSC Server or the FieldPoint VI-Based Server, complete the 
following steps after upgrading from version 6.x of the DSC Module 
Run-Time System. 

1. Uninstall FieldPoint Explorer if you are using a version earlier 
than 3.0.1. 

2. Download and install a more recent version of FieldPoint Explorer.

• If you install FieldPoint version 3.0.1 or 3.0.2, mass compile 
the FieldPoint IAK server (the contents of the <LABVIEW>\ 
_servers\FieldPoint folder), and export the configuration 
to the DSC Module Run-Time System by selecting 
BridgeVIEW»Export to BridgeVIEW from FieldPoint 
Explorer. 

• If you install FieldPoint version 4.0, save a backup of the .scf 
file and then revise it to use the FieldPoint OPC Server in one of 
two ways: 

– Use the Tag Configuration Wizard to generate a new set of 
tags using the National Instruments.OPCFieldPoint server. 

– Edit the configuration of each FieldPoint tag. On the 
Connection tab, change the Server Name to National 

Table 3.  Special Access SQL Characters

Special Character Converted Character

period (.) at sign (@)

forward slash (/) backslash (\)
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Instruments.OPCFieldPoint. Add the tag to an I/O Group 
and select the appropriate Item.

Known Issues
For recent known issues not included in these release notes, refer to the 
dscrts_readme.html file. Version 7.1 of the DSC Module Run-Time 
System has the following known issues.

Installation
• If you install the DSC Module Run-Time System on a non-English 

version of Windows, the following error message appears:

(Error 1931. The windows installer service cannot 

update the system file <system 

path>\mscpxl32.dll...)

This error appears because the DSC Module installs Microsoft Data 
Access Components (MDAC) version 2.7, but installing on a 
non-English version of Windows requires MDAC 2.7 service pack 1, 
available at the following location:

http://www.microsoft.com/downloads/details.aspx?Fam

ilyID=9ad000f2-cae7-493d-b0f3-ae36c570ade8&DisplayL

ang=en

• Due to a change in Citadel, you must install a patch for version 7.0 of 
the DSC Module if you want to run both version 7.0 and 7.1 on the 
same computer. The patch for version 7.0 is located on the installation 
CD in the Simultaneous Operation Patch folder.

• cwui.ocx cannot be registered on a Windows XP computer that has 
Crystal Reports 8 installed. Complete the following steps to work 
around the problem by granting the user full access to the cwui.ocx 
type library registry key and its subkeys.

1. Open the registry editor and select the cwui.ocx key, 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\TypeLib\

{D940E4E4-6079-11CE-88CB-0020AF6845F6}.

2. Select Edit»Permissions and select the appropriate user.

3. Click the Advanced button, click the Edit button, grant full 
control, and click the OK button.

4. Enable the Replace permission entries on all child object 
switch entries shown here that apply to child objects option 
and click the OK button.

5. From a command prompt, run regsvr32 cwui.ocx to manually 
register cwui.ocx.
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Data Logging and Retrieval
• NI cannot guarantee that all data is preserved after a computer crashes 

or the power fails. NI recommends that you use NTFS (NT File 
System) and uninterruptible power supplies for computers that are 
acquiring or logging data. 

• If you quit the Tag Engine using the Task Manager, the Citadel 
database can be corrupted.

• Database names cannot contain certain characters. They must contain 
only characters A–Z, a–z, 0–9, and the underscore character ( _ ).

• Periodically, you might see CPU usage at 100% due to Citadel and 
SQL services, even when no clients are present.

• Converting a large (2 GB or more) Citadel 4.x database to Citadel 5 
is slow.

• In Historical Data Viewer, A&E Views might not work after a 
destructive database archive.

• When changing an NI HyperTrend y-axis Minimum and Maximum, 
the Apply button does not work. Click the OK button to apply the 
change. When changing an NI HyperTrend x-axis Width, you must 
right-click the NI HyperTrend and select Restore X Axis Width from 
the shortcut menu to apply the change.

• If a remote database connection is lost while a client computer is in 
hibernation mode, an NI HyperTrend display on the client computer 
might hang.

• If you try to configure data sets when the Tag Engine is running, you 
can select tags only from the .scf file being used by the Tag Engine.

• If the network connection is lost during an archive operation to a 
remote computer, the operation times out and aborts instead of waiting 
for reestablished communication.

OPC
• The DSC Module OPC server does not support non-Western 

character sets.

• In Server Explorer or Server Browser, browsing to remote OPC servers 
might not work for certain operating systems.

• Even when an OPC server has items off scan, the Tag Engine can 
connect to the items and the .scf file sets initial values for the items.

• The OPC Demo server might not correctly unload when the Tag 
Engine stops. Exit LabVIEW to unload the server.
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• In Server Explorer, you might receive error 0x80080005 when trying 
to launch the OPC LabVIEW server.

• The Tag Engine might not shut down as expected after OPC clients are 
disconnected. If you lose a connection to the OPC Server and you try 
to shut down the Tag Engine on the client computer, the Tag Engine 
might appear to hang. However, the Tag Engine is not hanging in this 
case. It is waiting for the timeout period, which is about three minutes.

Communication and Dialog Boxes
• If data is being written to the Tag Engine while an application is 

reading a trend with a large number of samples (100,000 or more) 
in a tight loop, the read might fail.

• When you attempt to start or stop the Tag Engine from the Engine 
Manager window, certain error messages might be placed under the 
Engine Manager window where you cannot see them.

• The DSC Module Run-Time System might not correctly report bad 
status for disconnected or unavailable FP-1600 modules.

• Tag control values might reset to 0 instead of the LabVIEW default 
value, last value held, or last value logged.

Tag Monitor
In Tag Monitor, denying read privileges causes a quality of access denied 
for write-only tags. The read/write column values also might not be 
accurate.

ICU License-ICU 1.8.1 and Later
The DSC Module Run-Time System uses code from the International 
Components for Unicode (ICU) libraries, for which the following license 
applies. Refer to oss.software.ibm.com/icu for more information 
about the ICU libraries.

COPYRIGHT AND PERMISSION NOTICE

Copyright (c) 1995–2003 International Business Machines Corporation 
and others

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy 
of this software and associated documentation files (the “Software”), to 
deal in the Software without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, and/or sell copies of 
the Software, and to permit persons to whom the Software is furnished to 
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do so, provided that the above copyright notice(s) and this permission 
notice appear in all copies of the Software and that both the above copyright 
notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY 
OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT 
SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN 
THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL 
INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES 
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER IN AN ACTION OF CONTRACT, 
NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF 
OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS 
SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall 
not be used in advertising or otherwise to promote the sale, use or other 
dealings in this Software without prior written authorization of the 
copyright holder.

All trademarks and registered trademarks mentioned herein are the 
property of their respective owners.

More Information and Updates
For information on DSC Module Run-Time System updates and changes in 
the future, visit ni.com/labviewdsc.

To download the newest NI patches and other updates, visit 
ni.com/downloads.
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